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About Suni Digital Intra-oral Camera 
 
Congratulations on choosing SUNI digital intra-oral camera! 

The Suni USB Intra-oral camera is designed for routine use in dental operatories for 

documentation and patient education purpose.  SuniCam provides you with high quality 

real-time digital video and still images in a clinical environment. The real time full motion 

video and picture snapshots can be displayed instantly in the SuniCam software at the 

dentist operatory. The digital images are captured using the state-of-art CCD digital 

imaging technology. The Suni USB Intra-oral camera is a true plug and play device for 

your desktop or laptop, convenient and portable. No extra power source is needed 

besides the USB cable. Still images can be captured at any time from the simple click on 

a button in the software or from the hand piece.  

 

The Suni USB camera is able to display the video and still image at a variety of formats 

and resolutions. The resolution of full motion video ranges from 640x480 to 160x120. 

The still image offers up to mega-pixel resolution. The frame rate varies from 5fps to 

30fps. 

 

The camera can be conveniently positioned in the patient’s mouth in almost any angle to 

obtain a high quality video and image of the teeth. The camera is comfortable to hold 

thanks to the ergonomic design. It is very light weight. The only light source needed to 

obtain a high quality image is the light source around the lens. The camera size is small 

and easily fits into the pocket. 

 

The video and images from the camera provide valuable diagnostic information to the 

dentist as well as educational value to the patient.  

 
Installation and setup of SuniCam system requires little work and computer knowledge. 

It is even easier to use the software. The user friendly and proprietary software 

integrates with the camera seamlessly. Suni USB camera will provide you a whole new 

experience for your practice.   
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About the SuniCam software 
 
This user guide describes the SuniCam utility software which is intended to integrate 

Suni USB camera in a stand alone fashion. It is a fully functional program for live video 

preview, still image acquisition as well as archiving. 

 

SuniCam Application software will be tailored to the dental practice. For detailed 

information and update, please contact your local SuniCam dealer. 

 

This camera is designed to be integrated into Dr. Suni and Prof. Suni software 

seamlessly.  They are your complete solution for digital radiography system and digital 

Intro-oral camera. 
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1. Introduction to SuniCam 
 

1.1 Camera specification 
 

Image sensor Sony ¼” progressive scan CCD 

Number of effective pixels 659(H) x 494 (V) 

Power supply 5V @ 440 mA provided by USB bus 

Cable length 2.5 meters  

Handpiece weight ~40g 

Handpiece maximum dimensions 180 mm (L) x 26 mm (W) x 20 mm (H) 

Depth of Field 10 mm ~ 45mm 

Type of Focus Fixed for Intraoral 

Field of View 56 degrees 

Frame rate Up to 30 frames per second 

Live video resolution Up to 640x480 

Still image resolution Up to 1280x960 

Light source 9 white LEDs 

 

 
Features:  

1. Integrated still image capture buttons. 

2. LED light source ON/OFF control button 
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1.2 System Requirements 
 

SuniCam is designed for 32-bit operating systems and can be installed on your existing 

network running Windows 98 or higher.  

 

Minimum System Requirement 
 - Pentium 200MHz or higher 

 - 64MB RAM 

 - Windows /98 

 - CD-ROM drive 

- 16-bit color video with the resolution display of 1024 X 768 

- Available USB port 

 
 

1.3 SuniCam  System Component  List 
 

•  USB Camera handpiece 

•  2.5 Meter USB cable with two type “A” connectors  

•       CD-ROM containing the camera driver and the SuniCam utility software  

•        Packet of camera sheaths.  
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2. System Setup 
 

2.1 Camera features 
 

USB cable should be plugged as shown in Figure 1.  There are two snapshot buttons 

(Front View and Back View in Figure 1), one on the front-side, the other on the back-

side. The two buttons serve the same purpose, offering convenience in getting a still 

image during your practice. The camera will remain ON as long as the USB cable is 

plugged to the PC and camera. The LED light on and off button serves to turn on the 

lights. Turn off the LED light when the camera is not in use. 

 

 
        Figure 1.  Picture of Suni USB camera 
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2.2 Set up the camera hardware 
 

 
Figure 2. Picture of USB connector 

 

In the component kit, you will find a 2.5 Meter long USB cable with two type “A” 

connector on both ends, as shown in Figure 2.  

Plug one end of the USB cable to the USB port on the PC. Plug the other end of the 

USB connector to the camera handpiece. This will complete the hardware setup.  
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2.3 Install the camera driver  
 

 

 
 

 

 

 

 
 

 

   

 
 

 

 

Step 1: 

 

Plug the SuniCam USB camera in the 

USB port on your computer. WinXP will 

detect the USB camera and attempt to 

load the driver for it. 

 

 

 

Step 2: 

 

A found New Hardware window will 

appear. Insert “ SUNI USB Camera 

Software” CD in your optical drive. 

Chose “ Select from a list or specific 

location (advanced)” option, then click    

“Next”. 

 

 

 

Step 3: 

 

The “ Please choose your search and 

installation options” dialog appears. 

Select “ Search for the best driver in 

these locations”. Check both boxes “ 

Search removable media (Floppy, CD-

Rom…)” and “ include this location in 

the search:”. In the area provided, type” 

D:\SuniUSB_driver” (If your CD-Rom 

drive is drive D: ). 
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Step 4: 

 

In the window “ … has not passed 

Windows Logo testing to verify its 

compatibility with Windows XP…”, click 

“Continue Anyway”.  

 

 

 

 

 

 

Step 5: 

 

Window XP will find the “ Suni Imaging 

Microsystem VGA Digital Camera 

Video”  driver and will install it. 

 

 

 

 

 

 

 

Step 6: 

 

The next dialog will let you know that the 

driver has completed installing. Click “ 

Finish” to finalize the installation.
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Note:  

The driver installation guide is intended for WinXP. The steps are similar for 
Win98, Win98SE, ME and 2000. 

 
2.4 Install SuniCam Utility Software 
Insert SuniCam Utility software CD in your CD drive. It will autorun and start the 

installshield wizard. If it doesn’t, browse to the CD and click Setup.exe to start the 

installation wizard.  

 
 

 
 
 

 
 
 
 
 

 
 
 
 
Step 1 
 
This is the first screen when installshield 
starts. It will install SuniCam utility 
program on your computer. Click “Next”. 
 
 
 
 
 
 
 
 
 
 
 
 
Step 2 
 
 
Input your user name and company 
name in the appropriate field. Click 
“Next”. 
 

 



Part # 400-1048   Rev A        March 18,2003  Printed in the United States of America 
 

12

 
 
 

 
 
 

 
 
 

 

 

Step 3 

 

The default folder for SuniCam utility 

 program is C:\Program files\SuniCam. If  

 a different path is preferred, browse to 

 that directory. Then click “Next”. 

 

 

 

 

Step 4 

 

The setup program will proceed with the 

 installation and copy the appropriate 

 files to your computer.  Click “Next”. 

 

 

 

 

 

 

Step 5 

 

Setup has finished installing SuniCam. 

 Click “Finish”. 
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Note: Either unplug the USB cable at the USB camera end and plug it back in 
or restart your computer to complete the installation of the software. 

 
2.5 Installing DirectX9.0 

You need DirectX version 7.0 or higher to run this software optimally. DirectX is a 

Microsoft program designed to run and display multimedia applications such as video. 

It enables high performance in these applications.  If you experience degraded 

performance of SuniCam utility software, you may need a newer version of DirectX to 

solve the problem. 

To check which version of DirectX is currently installed on your machine, click Start -
>Run. In the area provided, type dxdiag, as shown in Figure 3. 

 

 

 
Figure 3. Run DirectX Diagnostic Tool 

 
Clicking OK in Figure 3 will bring up the DirectX Diagnostic Tool window (Figure 4). This 

tool  tells the version of DirectX on your computer. For example, this particular computer 

has DirectX is 8.1 on it. If your DirectX version is lower than 7.0, you need to install 

DirectX9.0 from the CD.  
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Figure 4. DirectX Diagnostic Tool 

 

To install DirectX9.0, insert the SuniCam CD in your CD_ROM drive and browse to 

DirectX9.0_redist folder, then double click setup.exe.  Follow the steps below to install 

DirectX9.0. 

 

 
 

 
 

 

 

 

 

 

 

Step 1 

 

Setup will try to install Microsoft 

DirectX9.0 on your computer. If you 

accept the agreement, click “Next”. 
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Step 2 

 

Click “Next”. 

 

 

 

 

 

 

 

 

 

 

Step 3 

 

The setup program will proceed with the 

 installation. 

 

 

 

 

 

 

 

Step 4 

 

Setup has finished installing DirectX9.0. 

 Click “Finish”. 

You need to restart your computer to 

apply the change.
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3.1 Launch the utility software 
The installer will create a shortcut of SuniCam utility program on your desktop. Start 

the program by double clicking the desktop icon or go to Start -> Programs ->SuniCam. 

 
3.2 Operation Procedure 

These are the steps for correct daily operation of the camera system: 

1. After starting Windows, plug the USB connector into the camera housing. 

2. Insert the new camera sheath over the camera, making sure the transparent part 

of the sheath is facing the lens and properly placed. 

3. Double click the desktop icon of “SuniCam” to launch the software.  

4. Turn on the LED light by pressing the LED ON/OFF button. See Figure 1 for 

location of button. 

5. Follow the procedure outlined in section 3.3 for various modes of operation. 

6. Once you finish using the camera, close the SuniCam utility program. 

7. Unplug the USB cable from the camera. 

8. Remove the used sheath and discard. Do not reuse sheath. 

9. The camera may be disinfected with alcohol or other disinfectant agent by 

wiping. Do not autoclave camera or immerse camera in any liquids. Doing so will 

void the warranty. (See safety and handling instructions.)   

10. Turn off the LED lights after use. 

 

Important!  Un-plugging the camera while the Suni utility program is running will 
result in incorrect operation of the software.  Always close the SuniCam utility 
program before unplug the USB cable from the camera.   
  

3.3 Operate the Suni utility software 
 
3.3.1 Turn the camera on and off 
There is no on/off power switch for the SuniCam Camera. Plug the USB cable on the 

camera and the PC, the camera is turned on automatically. Turn on the camera light by 

pressing the appropriate button (Refer to Figure 1). Turn off the light when the camera 

is not in use. 
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3.3.2 Set up the live video preview 
After you opened the program, a preview window will be present in the main window as 

shown in Figure 5. Real time live video will be displayed. The SuniCam USB camera has 

fixed focus lens. As you preview the video, focus by adjusting the distance of the lens to 

the imaging object until the image is clear.  

 

 
 

Figure 5. SuniCam Program and Preview window 

 

There are three buttons on the top of the preview window, Capture, Control and Setup.  

Each of the buttons is explained below: 

 

Capture button is explained in Section 3.3.3 under Capture the snapshot.

Control button offers a list of camera control features as displayed in Figure 6.  

 



Part # 400-1048   Rev A      March 18,2003  Printed in the United States of America 
 

18

 
 

Figure 6. Camera control property 

 

Image control allows for adjustment of brightness, contrast, gamma value and 

saturation of the video stream and still image.   

 
Exposure of the camera was controlled by the shutter speed and Gain. If set to Auto,  

the exposure is determined by the camera automatically. 

 

Frame rate means the number of video frames per second (f/s). It is adjustable in a 

range of 5f/s, 10f/s, 15 f/s, 20f/s, 25f/s and 30f/s. 

 

Restore button under user default will retrieve a last saved setting for overall camera 

controls. The factory default setting is recalled and loaded when restore button under 

factory defaults is clicked. The factory default setting, however, is not changeable by the 

end user. 

 

If full Auto Mode is selected, all the camera control options become automatic.  

 
If a Black and white video or image is preferred, check the Black and white option under 

Image Modes. Mirror X will display the video and image in a horizontally flipped 
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manner. Likewise, Mirror Y will display the video and image in a vertically flipped 

manner.  Backlight compensation will adjust the exposure for an object when its 

background is too bright. 

 

White balance corrects the colors for video and images so that an object will show its 

true color under a variety of lighting conditions.  

 
Occasionally, there are horizontal zebra lines on the images when there is only one 
lighting source and the source is not very bright. Check “off” under Flickerless when this 
happens. 
 
The resolution of video and still image can be selected if click on Setup button. 

SuniCam software supports 640x480, 320x240 and 160x120 resolutions for live video 

streams. For still image resolutions, 1280x960, 1024x768, 800x600, 640x480, 320x240 

and 160x120 are supported.  

 

 
Figure 7. Video and image resolution selection 

 

 

Shutter sound can be switched on or off by clicking the on/off radio button.  

 

3.3.3 Capture the snapshot 
A still image can be captured from both the SuniCam software and the camera 

handpiece.  On the handpiece there are two snapshot buttons (see Figure 1), one on the 

front and one on the backside. They serve the same purpose, offering convenience of 

getting a still image. 
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Position the camera headpiece at a desired image view, click the capture button on the 

preview window or press the snapshot button on the handpiece. The captured image will 

be placed in the thumbnail window on the right side of the program window. Each of the 

captured images will be given a name automatically by the camera program.  

 

 
Figure 8. Thumbnail window on/off 

 

 

 

 

The thumbnail window can be toggled 

on or off by selecting View -> Image List 

 

3.3.4 Open existing images 
All the images previously saved in C:\Windows\temp\SuniCamImages will be recalled 
and loaded in the thumbnail window when the program starts. 
 
To open images from directories other than the one mentioned above, choose  
File ->Open. A dialog box (Figure 9) will appear.  
 

 
 

Figure 9. File Open Dialog 
 
You can browse to the proper directory and open image files. Available file formats are: 
JPEG, bitmap and TIFF. 
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3.3.5 Save the images  
To save an image, highlight the image in the main window and choose File-> Save as 

option from the menu bar. Alternatively, you can save an image by highlighting the 

thumbnail image, clicking the right mouse button and selecting Save as.  Images can be 

saved in one of the three format : JPEG, bitmap and TIFF.   

More options are available for JPEG or TIFF format under Options-> image format as 

shown in figure 10.  The quality of a JPEG image can be adjusted on the scale of 0-100 

by moving the slider in Figure 10. 100 gives the lowest compression ratio and thereby 

the highest JPEG image quality. When TIFF image format is desired, there are two 

further options : LZW compression or no compression. LZW compression usually gives 

slightly smaller file size. 

 

 
Figure 10.  More on Image format 

 

 

 

 

 

 

More options are available for JPEG 

and TIFF formats 

 

 

 

 

Images in the thumbnail bank can be saved or deleted by right mouse click. If there are 

any images left unsaved upon closing the program, the user will be presented with a 

dialog (Figure 11), prompting whether to save these images and to which folder.  
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Figure 11. Save images 

 

“Save as” gives you the option to save each image in a selected folder you desired.  

“Save All” gives you the option to save all the thumbnail images into one designated 

folder with the default image names. “Discard” will discard all the images. “Save to 
Temp Dir” will restore the image data in the default temp directory : 

C:\Windows\temp\SuniCamImages  (you have the option to change the path of this 

directory). Next time when you start SuniCam program, these images in the default 

directory will be available in the thumbnail bank.  

 

 

3.3.6 Work with still images 
All the images captured will be shown as icons in the thumbnail bank. To enlarge it to full 

size, you need to select the image and double click the icon (Figure 12).  If the main 

window is not large enough for the image, a “hand” symbol will appear, you can pan the 

image within the main window.          
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.  

Figure 12. Still image manipulation 

 

All images with bitmap format in the default directory  

(C:\windows\temp\SuniCamImages) will be loaded to the thumbnail window when the 

program starts. 
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Use camera Sheaths 
 

The SuniCam System uses disposable sheaths to ensure proper hygiene and to protect 

against infectious disease. The sheaths are intended for a one-time use and are to be 

disposed after use.  

 

Before using the intraoral camera, insert a new sheath, making sure the clear or 

transparent portion of the sheath is placed properly over the lens. After use of the 

camera in a patient’s mouth, remove the sheath from the camera and properly dispose 

the used sheath. A new sheath shall be used with each new patient. 

 

A limited sample of SuniCam sheaths are supplied with your SuniCam system. 

Additional sheath may be obtained through your dealer or you may contact Banta 

Healthcare for additional sheaths. (800-215-5464, www.bantahealthcare.com) 
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SAFETY AND HANDLING INSTRUCTIONS FOR THE  
DIGITAL CAMERA SYSTEM 
 

IMPORTANT: Disconnect camera from USB cable before performing any cleaning. 
 
Maintenance: 
Components of SuniCam are made with high quality materials. No specific maintenance 

of the system is required. Normal care and maintenance will result in many years of 

service. The external surfaces of the USB camera should be kept clean by wiping with a 

slightly alcoholdamp cloth occasionally. Do not immerse the camera in any liquids or 

disinfectants. To clean the lens surface, use a cotton Q-tip moistened with rubbing 

alcohol and gently wipe the lens surface, wait till it dries. 

 

Troubleshooting: 
Every precaution has been taken to ensure that your SuniCam will function properly. All 

components are pre-tested in your system before shipping.  

 

Should you experience difficulty, do the following before contacting your sales 

representative. Be sure to be ready to describe your problems in detail, including any 

error messages that might be displayed.  

•  Although it seems obvious, you should always check to ensure that all 

connections are securely made, and that the power to your computer and 

monitor is turned on. 

•  Do not open your camera and attempt to alter internal connections. The camera 

should only be serviced by the manufacturer. It contains no user serviceable 

parts. 

 

Operating Conditions: 
This equipment is rated for continues use. 

Operating Temperature and Humidity 0 0C to +40 0C with a RH of 30-75%. 

This equipment is not suitable for use in the presence of flammable mixtures. 
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Using the System:  
The product shall be used in accordance to the directions and recommendations in the 

User Guide. User shall make no attempt to modify or alter the equipment, or use this 

equipment other than its intended design.  

 

Explanation of symbols: 
Symbols in the SuniCam Label identify the product as having met requirements within 

the US and for International markets. The “CE” symbols are examples of this type mark. 

Other symbols provide technical or other information. 

 
  
EMC Statement: 

 

Type II Class Equipment 
Accessories equipment connected to the analog and digital interfaces must be certified 

to the respective IEC standards (i.e. IEC 950 for data processing equipment and IEC 

601-1 for medical equipment.) Furthermore all configurations shall comply with the 

system standard IEC 601-1-1. Everybody who connects additional equipment to the 

signal input or signal output configures a medical system, and is therefore, responsible 

that the system complies with the requirements of the system standard IEC 601-1-1. If in 

doubt, consult the technical services department or your local representative. 

 

This equipment has been tested and found to comply with the limits for medical devices 

to the IEC 601-1-2:1994. These limits are designed to provide reasonable protection 

against harmful interference in a typical medical installation. This equipment generates, 

uses and can radiate radio frequency energy and, if not installed and used in 

accordance with the instructions, may cause harmful interference to other devices in the 

vicinity. However, there is no guarantee that interference will not occur in a particular 

installation. If this equipment does cause harmful interference to other devices, which 

can be determined by turning the equipment off and on, the user is encouraged to try to 

correct the interference by one or more of the following measures. 

This symbol indicates that this product is Type BF 
Equipment. 
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� Reorient or relocate the receiving device 

� Increase the separation between the equipment. 

� Connect the equipment into an outlet or a circuit different from that to which the other 

device(s) are connected. 

� Consult the manufacturer or field service technician for help. 

 

Follow local governing ordinances and recycling plans regarding disposal or recycling of 

device components. 
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LIMITED WARRANTY 

 
(1)  Suni Imaging Microsystems, Inc. warrants to the original purchaser that the 
SUNI-CAM Intraoral Camera (the “Product”) will be free from material defects in material 
and workmanship for a period of 12 months from the date of original purchase from Suni 
Imaging Microsystems, Inc. or its authorized distributor (the “Warranty Period”). During 
the Warranty Period, Suni Imaging Microsystems, Inc. will repair Product not meeting the 
foregoing Limited Warranty (or at its option, replace such Product with a new or 
reconditioned Product) at no charge. Any replacement or repaired Product will be 
warranted for the remainder of the original Warranty Period.  All Products or parts 
replaced become Suni Imaging Microsystems, Inc.’s property.  If neither repair or 
replacement is reasonably available, Suni Imaging Microsystems, Inc. may elect instead, 
at its option, to accept return of the Product and refund the purchase price of the 
Product.  This Limited Warranty only covers the hardware components of this Product.  
This Limited Warranty does not cover, and Suni Imaging Microsystems, Inc. is not 
responsible for, any software that may be used with this Product.  This Limited Warranty 
extends only to the original purchaser and is not transferable to anyone else.  Fill out the 
bottom of this Limited Warranty and mail a copy along with a copy of the bill of sale to 
the address indicated. 
 
 (2) To obtain warranty service you must:  (a) obtain a return materials authorization 
number (RMA#) from Suni Imaging Microsystems, Inc., and (b) deliver the Product, in 
accordance with the instructions provided by Suni Imaging Microsystems, Inc., along 
with proof of purchase in the form of a copy of the bill of sale including the Product’s 
serial number, contact information, RMA# and detailed description of the defect, freight 
prepaid, in either its original package or packaging providing the Product with a degree 
of protection equivalent to that of the original packaging to the distributor whom you 
purchased the Product from or if purchased from the factory to Suni Imaging 
Microsystems, Inc.  Suni Imaging Microsystems, Inc. is not responsible for any damage 
to the Product during transportation. Be sure to remove all parts, options, holders and 
attachments prior to delivering the Product. Suni Imaging Microsystems, Inc. is not liable 
for any loss or damage to such items. 
 
(3) This Limited Warranty does not cover any consumables (such as sheaths) 
supplied with this Product, cosmetic damage, damage due to (a) acts of God, accident, 
misuse, abuse, negligence, abnormal or unusually heavy use, causes external to the 
Product such as but not limited to excessive heat or humidity, or modifications to this 
Product, (b) improper installation, operation, testing, or maintenance of this Product, (c) 
power failure or connections to improper voltage supply, or (d) attempted repair by any 
party other than Suni Imaging Microsystems, Inc.  This Limited Warranty does not apply 
when malfunction results from the use of the Product in conjunction with accessories, 
products or ancillary or peripheral equipment not provided by Suni Imaging 
Microsystems, Inc., or where it is determined by Suni Imaging Microsystems, Inc. that 
the Product itself complies with the Limited Warranty. This Limited Warranty does not 
apply if the Product: is damaged by Electrostatic Discharges (ESD); is damaged as a 
result of autoclaving the camera; is immersed in any liquid such as disinfectants, alcohol 
or any other liquid; sustains damage to internal components; is damaged as a result of 
shock impact (such as dropping the Product); or is damaged as a result of clamping the 
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Product with hemostats or other utensils that deform, dent or damage the camera 
enclosure. This Limited Warranty is invalid if the Product is used for purposes other than 
the use intended by Suni Imaging Microsystems, Inc.  This Limited Warranty is invalid if 
the factory-applied serial number has been defaced, altered, obliterated or removed from 
the Product. 

(4) Suni Imaging Microsystems, Inc. shall not be liable under this Limited Warranty if 
Suni Imaging Microsystems, Inc. (a) cannot reproduce the alleged defect in its testing 
and examination of the Product or (b) discovers that the Product is excluded from 
coverage under this Limited Warranty for any reason. 

(5) Repair, replacement or return/refund as provided under this Limited Warranty is 
the sole and exclusive remedy of the customer for any breach thereof.   

(6) TO THE FULL EXTENT ALLOWED BY LAW, THE FOREGOING LIMITED 
WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ALL OTHER 
WARRANTIES, TERMS, OR CONDITIONS, EXPRESS OR IMPLIED, EITHER IN FACT 
OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING 
WARRANTIES, TERMS, OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, SATISFACTORY QUALITY, CORRESPONDENCE WITH 
DESCRIPTION, AND NON-INFRINGEMENT, ALL OF WHICH ARE EXPRESSLY 
DISCLAIMED.  SUNI IMAGING MICROSYSTEMS, INC. NEITHER ASSUMES NOR 
AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN 
CONNECTION WITH THE SALE, INSTALLATION, MAINTENANCE OR USE OF ITS 
PRODUCTS. 

(7) TO THE FULL EXTENT ALLOWED BY LAW, SUNI IMAGING 
MICROSYSTEMS, INC. ALSO EXCLUDES FOR ITSELF AND ITS SUPPLIERS ANY 
LIABILITY, WHETHER BASED IN CONTRACT OR TORT (INCLUDING 
NEGLIGENCE), FOR INCIDENTAL, CONSEQUENTIAL, INDIRECT, SPECIAL, OR 
PUNITIVE DAMAGES OF ANY KIND, OR FOR LOSS OF REVENUE OR PROFITS, 
LOSS OF BUSINESS, LOSS OF INFORMATION OR DATA, LOSS OF USE OF 
PRODUCT, OR OTHER FINANCIAL LOSS ARISING OUT OF OR IN CONNECTION 
WITH THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE, FAILURE, 
OR INTERRUPTION OF THIS PRODUCT, EVEN IF ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES, AND LIMITS ITS LIABILITY TO REPLACEMENT, REPAIR, OR 
REFUND OF THE PURCHASE PRICE PAID FOR THE PRODUCT BY CUSTOMER, AT 
SUNI IMAGING MICROSYSTEMS, INC.’S OPTION.  THIS DISCLAIMER OF LIABILITY 
FOR DAMAGES WILL NOT BE AFFECTED IF ANY REMEDY PROVIDED HEREIN 
SHALL FAIL OF ITS ESSENTIAL PURPOSE.  Any implied warranty which cannot be 
disclaimed shall be limited in duration to the minimum duration required by applicable 
law or the Warranty Period, whichever is greater. This Limited Warranty gives you 
specific legal rights and you may have other rights, which vary, from jurisdiction to 
jurisdiction. Some jurisdictions do not allow the exclusion or limitations of special, 
incidental or consequential damages or limitations on how long a warranty lasts, so the 
above exclusion and limitation may not apply to you. 

(8) This Limited Warranty shall be governed by the laws of the State of California, 
U.S.A. excluding its conflicts of laws principles and excluding the United Nations 
Convention on Contracts for the International Sale of Goods. 
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